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Introduction 
 
Software Translator is an aid for translating Windows software from one language to another. 
Software Translator comes with a number of general dictionaries containing phrases that are 
commonly used in the Windows environment. 
 
Of course, different programs have different vocabularies, and for a program to be translated in its 
entirety you need to supplement the dictionary with words and phrases specific to the program in 
question. Up-to-date information on complete dictionaries for various programs is available from the 
Eurocity Software website www.eurocitysoftware.com. Contact info@eurocitysoftware.com for help 
with producing dictionaries for specific programs. 
 
All programs translated using Software Translator may have unique dictionaries. If there are several 
programs with similar vocabularies, you could use the same dictionary for a number of programs. 
 
In order to identify all the text in a program’s user interface – the source code phrases – Software 
Translator uses a special function, “Capture UI”. UI is an abbreviation for the term “User Interface”. It 
reads a program’s user interface and enables you to import the source language phrases into a 
program-specific dictionary. In this way, you can supplement the dictionary provided with phrases from 
any program. The translation of these phrases is done manually, but once done can then be re-used 
for future versions of the program or in other programs with similar vocabularies. 
 
A situation may arise where there is insufficient space for the translated text due to the translation 
being longer than the original source phrase. In most instances, Windows deals with this 
automatically. However, there are a few occasions where this is not possible (buttons, check boxes, 
radio buttons and static text). Software Translator features a function to adjust sizes where required. 
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Setup.exe

Installation 
 
Insert the CD (in this example, the CD drive is D:) 
 
Option 1: Open Windows Explorer and scroll down to the CD. Double-click 
Setup.exe. 
Option 2: Click the Start button, then select Run. Type “D:\Setup” and click OK. 
 
Follow the instructions on screen. 
 
Once installation is complete, you can launch Software Translator by double-
clicking the icon on the desktop or by clicking the Start button and selecting 
Programs -> Software Translator.
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Authorization  
 
The first time you start Software Translator, this dialog box will be 
displayed. The “Request Code” is generated automatically and is 
unique for each computer.  
 
Click “Get Authorization Code” to generate an authorization code. 
If Software Translator is unable to establish contact with the 
Internet it may be because your computer is behind a firewall. If 
this is the case, try requesting the code using your web browser 
instead. 
 
Swedish page: 
www.eurocitysoftware.com/huvudsidan/authorize_s.htm 
English page: 
www.eurocitysoftware.com/mainpage/authorize_s.htm 
 
The code will be sent to the e-mail address given in the “e-post” 
field (authorization can only be submitted by e-mail). 
 
Copy the authorization code from the e-mail message and paste it 
into the “Enter Authorization Code” field. You can, of course, also 
enter the code manually. 
Once the right authorization code has been entered, the 
“Authorize” button will activate.  
Click the button to authorize Software Translator. 
 
 
Simple authorization 
 
Software Translator is sometimes supplied with a simple authorization. 
In this example, you need only enter the serial number.  
Software Translator retrieves the authorization code automatically.  
Click Cancel to run the program in evaluation mode. 
 
 
 
 
 
 
If you are installing Software Translator on a computer with no Internet connection: 
 
Make a note of the Request Code and serial number and use another computer to get the 
authorization code. See the website address given above. During this time, you can use Software 
Translator in evaluation mode. The evaluation version is fully functional, but you can only launch the 
program a limited number of times. 
 
The “Authorize Software Translator” dialog box pops up each time you start the program until the 
authorization code field is filled in.  
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Overview 
 
Program window 
 
Menu bar 
 
Source language 
 
Target language 
 
 
 
 
 
 
Applications 
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Operation 
 
 
Adding a program for translation  
Select New... from the File menu, or right-click in the Program 
window and select New... from the right-click menu.  
Browse to the program’s EXE file or shortcut. Select the EXE file 
or shortcut and click “Open” or double-click the file. An icon is now 
added to the applications window. 
 
You can also add a program by dragging program icons and 
shortcuts from the desktop or start menu and dropping them in the 
applications window. 
 
 

Right-click menu in applications 
window. When no icon is selected. 
 

 
 
 
 
Starting a program for translation  
 
First select the “Source Language” and “Target Language” by clicking the radio buttons next to the 
relevant flags. Then either double-click the program icon, right-click and select “Run” from the right-
click menu or select “Run” from the File menu.  
 
Only programs launched from Software Translator will be translated. If programs are to be run without 
being translated, launch them from the Start menu or the desktop.  
You can also select a program and launch it by pressing Enter. 
 
The first time you use Software Translator, this dialog box will be displayed.  
 

 
 
It is important to understand why seemingly simple phrases are not translated. This is usually because 
the phrase is not in the dictionary. Software Translator comes with an integrated standard dictionary.  
It contains the most commonly used Windows phrases in 27 languages. However, the dictionary must 
almost always be augmented by phases that are specific to the program to be translated. The “Don’t 
show this dialog again” setting can also be controlled from the “Software Translator Options” dialog 
box.  
Select “Options…” from the “Tools” menu. Select “Show Lexicon Information Dialog”. 
 
See the section “Adding phrases from a program’s user interface”. 
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Deleting a program icon  
 
Select the program and go to the File menu. Select “Remove”. 
Alternatively, you can use the right-click menu. Right-click the 
relevant program icon and select “Remove” from the right-click 
menu. The Delete key also deletes a program icon. 
 
NB: Dictionaries created for the program will remain after the 
program icon has been deleted. Folders with the same name as 
the program translated will be created automatically in the folder 
in which Software Translator is installed. These folders contain 
the dictionary files, which have a TXE file extension. 
 

R
ight-click menu in applications 
window when an icon is selected. 
 

 
 
 
Adding phrases from a program’s user interface 
 
Close the program to be translated, then highlight the relevant 
program and select “Application Properties” from the “Tools” 
menu or right-click the program icon and select  “Application 
Properties…” from the right-click menu.  
 
 
 
 
 
 
 
 
 

Right-click menu in applications 
window 
 

 
 
Check the “Capture UI” (Capture user interface) 
box.  
“UI” is the abbreviation for “User Interface”. 
 
Then click OK and launch the program. All texts 
which have not been translated will now be 
captured.  
Go through the program and “show” Software 
Translator all the texts on screen. All texts which 
appear on screen can then be imported to the 
dictionary. 
 
Remember that a new capture session is started 
every time the program is launched if “Capture UI” 
is checked. We therefore recommend that you 
import phrases found before re-launching the 
program. 
 
 The “Application Properties” dialog box with 
  “Capture UI” box checked 
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Close the translated program and go back to 
“Application Properties”, click the “Edit” button to 
open Lexicon Editor.  
The “Show Capture” button in the bottom left 
corner of “Lexicon Editor” should now be active. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Lexicon Editor with “Show Capture”” button activated. 
 
 
 
 
 
Before the phrases are imported into the 
dictionary, they are subjected to a general 
check. Numerical values, duplications, etc. are 
removed. 
 
The top bar shows the total number of phrases 
that have been captured and the number of 
phrases that have been imported so far. 
 
The bottom bar shows the progress of the duplication check for each phrase. This can take some time, 
depending on how many phrases have been captured. 
The duplication check can be stopped by clicking the “Disable Duplicate Check” button. 
 
If the import is canceled, the phrases imported to that point will be entered into Lexicon Editor. 
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Lexicon Editor with the “Avläst UI” column displayed and the Målprefix function activated 
 
Double-click on a phrase to move it from “Captured UI” to the dictionary. Use the Shift and Ctrl keys to 
select multiple phrases simultaneously. Click the “>>” button. 
Where the translation is to be done at a later date or by someone else, a “test translation” can be done 
using the “Target Prefix” function. See below. A text string is placed in front of the phrase in the target 
column. This enables you to quickly import phrases and check that everything in the program has 
been “translated”. The actual translation can be carried out at a later date. 
 

 
Lexicon Editor with some phrases imported with the “Target Prefix” function activated. 
 
Click on a phrase in either the source or target column to edit the content. The Tab key opens the next 
phrase for editing. Pressing Shift+Tab opens the previous phrase. Pressing Ctrl+Tab changes column. 
 
Click OK to save the changes and close Lexicon Editor. If it is running, close the translated program 
and re-launch it from the applications window.
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Editing phrases in the dictionary 
 
Software Translator comes with a number of general 
dictionaries. When a program is launched, a unique 
dictionary is created automatically for this program. 
This dictionary is bilingual, having both a source 
language and a target language. You can edit the 
dictionary using “Lexicon Editor”. 
 
Highlight the program and select “Application 
Properties” from the “Tools” menu, or right-click the 
program icon and select  “Application Properties” 
from the right-click menu.  
 
 
 
 
 
        The “Application Properties” dialog box 
 
 
To edit phrases, click the “Edit” button.  
This opens “Lexicon Editor” and displays the phrases stored in the dictionary. If a large number of 
phrases are to be imported from a program, see the section “Adding phrases from a program’s 
user interface”. 

 
Lexicon Editor with a phrase open for editing. In this example, “Redigera” will be translated as “Edit” 
 
 
Add a new phrase by clicking the “New Phrase” button. 
Alternatively, you can right-click on a phrase and select “New Phrase” or 
“Insert  phrase”. 
“New Phrase” adds the new phrase to the end of the dictionary.  
“Insert  phrase”  inserts the new phrase above the highlighted phrase. 
 
Click on a phrase in either the source or target column to edit 
the content. The Tab key opens the next phrase for editing. Right-click menu in Lexicon Editor 
 when a phrase is highlighted. 
 
Pressing Shift+Tab opens the previous phrase. Pressing Ctrl+Tab changes column. 
 
Click OK to save the changes and close Lexicon Editor. 
If it is running, close the translated program, re-launch it from the applications window and check that 
the translation is correct. 
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Changing the size of a button or text field 
 
Here is an example from the search dialog in 
Windows Notepad. The phrase “Sök efter:” 
shall, according to the system dictionary, be 
translated as “ Dateien prüfen auf:”. 
 
However, in this instance there is insufficient 
space for the text. Therefore, this general 
phrase from the system dictionary must be 
replaced with a phrase adapted for “Notepad” 
 

 
Highlight the phrase and click “Delete” to delete it from the dictionary. Click OK to close Lexicon Editor 
and save the change. Close “Notepad” and re-launch the program to apply the change. 
 
The search dialog now appears without the 
translation of “Sök efter:” Open Lexicon Editor 
again. Click the “Properties” button 
 
1. In the “Phrase Properties” dialog box, click 
“Get Phrase From Screen” and hold your left 
mouse button.  
2. Drag the pointer to the text “Sök efter:” and 
release the mouse button.  
3. Translate the text in the “Target Phrase” field. 
In this example, the text “Dateien prüfen auf:” 
from the system dictionary has been entered. 
4. Change the size of the text area by clicking the 
up arrow under “Height”. Change to 14. 
Change the position of the text using the down 
arrow under “Up/Down”. Move down to -4. 
 
5. Click OK to close the “Phrase Properties” dialog 
and save the changes. Close Lexicon Editor by 
clicking OK. 
Close and re-launch Notepad to validate the 
translation. 

 
 

The “Notepad” search dialog with one text translated and size changed

5

2

3

1
4
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Using the search function in Lexicon Editor 
 

 
The search can be limited to the relevant column in Lexicon Editor.  
”Captured UI” is activated if the column is activated. See section “Adding phrases from a program’s 
user interface” for details of how to activate the “Captured UI” column. 
 
Use the “Get Phrase” buttons to quickly retrieve phrases from the various columns to use as search 
words. Start by highlighting the phrase and then click the corresponding “Get Phrase” button. 
 
 
 
Using the same dictionary for multiple programs  
 
 
If there are a number of programs which 
can be translated using the same 
vocabulary, it is practical for them to use 
the same dictionary.  
 
Highlight the relevant program and select 
“Application Properties” from the “Tools” 
menu, or right-click the program icon and 
select ““Application Properties”.  
 
Then click “Browse” and find the 
dictionary file. The files will have a TXE 
extension.  
 
 
 
 
 
 
 
 
The first time the programs are launched in Software Translator, dictionaries will be created 
automatically in the folder in which Software Translator is installed. A folder for each program will be 
created here. Of course, you can organize the dictionaries any way you like. Use the “Browse" button 
in the “Application Properties” dialog box to link the programs to any dictionary. 
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Looking up phrases in the dictionary 
 
Software Translator can act as a reference book or, more 
appropriately, an IT dictionary. Go to the “Tools” menu 
and select “Options”. Check the “Show Dictionary in” 
check box. Using the flags, select which languages are to 
be displayed in the dictionary. Double-click the “Lexicon” 
icon. 
 
 
 
 
 
 
 
 
 ”Software Translator Options” dialog box with 
 “Show Dictionary in Application list” activated. 
 

   
 
 
Example of a English – German dictionary 
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Menus 
 
File 
 
New... 
Adds a program to be translated. Browse to the EXE file or the shortcut for the 
program in question. 
 
Run 
Launches a selected program and translates it according to the flag settings.  
Remember that the source language flag must correspond to the original language of the program. If 
the program is English to begin with, the British flag must be selected as the source language. Of 
course, you can choose any target language – this is the language that will appear on screen when 
the program is run.  
The first time a program is launched, a sub-folder is created in the folder in which Software Translator 
is installed. All dictionaries for each program are created here. The filenames include the name of the 
program, the source language and the target language.  
Example: If the program Notepad.exe is translated from Swedish to English, a folder called “Notepad” 
is created, and in that folder, a dictionary called “Notepad_sve_eng.txe” is created. 
 
You can also launch a program by highlighting an icon using the arrow keys and then pressing Enter, 
or by double-clicking the program icon. 
 
Remove 
Removes a program from Software Translator. The program is not uninstalled, only the icon (shortcut) 
in Software Translator is removed. Any dictionaries created will not be removed.  
Using the Delete key is another way of removing selected programs. 
 
Exit 
Closes the Software Translator interface. The translation engine remains in operation. To completely 
close Software Translator, right-click the icon on the taskbar tray (map of the world). Select “Close 
Software Translator” from the menu.  
All settings made are saved. Remember that there may be programs running which are being 
translated by Software Translator. There is a danger that these programs will only be partly translated 
if Software Translator is closed. Therefore, we recommend that you close programs being translated 
before exiting Software Translator. 
 
View 
 
Large icons 
The list of programs appears as large icons. Mirrors the same setting in 
Windows Explorer. 
 
Small icons 
The list of programs appears as small icons in several columns. 
 
List 
The list of programs appears as a list in a single column.  
 
Details 
Displays a detailed list showing the settings for each program. 
 
Hide Software Translator 
Hides the Software Translator window. Show the window by double-
clicking the icon in the bottom-right of the taskbar tray. Right-click the icon 
to bring up the menu. 
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Language 
 
Source Language 
The original language in which the program was written.  
Select a language from this menu, or click one of the flags in the 
“Source Language” group window. 
This setting must match the source language of the program in 
question. Naturally, you cannot translate an English program from 
German into Swedish. What Software Translator “sees” in this case 
is English, and then looks for phrases in the source column in the 
dictionary. Of course, in this case the source has to be in English for 
Software Translator to find anything to translate. 
 
 
 
 
 
Target Language 
The language into which the program is to be translated. Select a 
language from this menu, or click one of the flags in the “Target 
Language” group window. Each program will have its own set of 
dictionaries depending on the source and target language settings. 
Therefore, it is possible to have a number of programs in Software 
Translator with different settings for the source and target language. 
Remember that it is the flag settings that apply when a program is 
launched. Check that the flags are correct before launching the 
program. If the program is not translated, it may be because the 
source language has been set incorrectly. 
 
 
 
 
Tools 
 
Application Properties 
Contains settings for each program in Software Translator. Select a program 
from the list to execute this command. 
There is information here on search paths for the program and the dictionary 
file, and the relevant source and target language. From here you can also 
activate “Capture UI”.  
This command is available only if a program is selected in the applications window. 
 
Options 
General settings, including the language to be used in Software Translator and the search path to the 
shared system dictionary.  
 
Help 
 
 To www.eurocitysoftware.com   
Launches your web browser and goes to the Eurocity Software website. 
 
Online Manual 
Opens the manual in .pdf format. 
 
 
About Software Translator... 
Shows which version of Software Translator is being used. 
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Dialog boxes 
 
Application Properties 
 
 
Button Function 
Edit Opens “Lexicon Editor”. 
 
Browse Browses to any dictionary. 
 
Capture UI 
 Captures texts from the program’s 

user interface. This can then be 
imported to 

 the dictionary. See “Adding 
phrases from a program’s user 
interface”. 

 This function cannot be combined 
with “Test mode”. 

 
Extended  Some programs need more 

advanced translation 
management.  

 If the program is not translated in 
its entirety, try selecting 
“Extended”. 

 
Deep Extended  Some programs require even more advanced management. Deep extended means 

that Software Translator also translates processes started by the translated 
program. 

 
Menus Activates translation of menus. 
 
ToolTips  Activates translation of ToolTips (a brief description that pops up when the pointer 

is held over a program feature, such as a button). 
 
List View Header  Activates translation of column headings (compare with “Details” in 
 Windows Explorer). 
 
List View Activates translation of Lists (compare with “List” in Windows Explorer). 
 
Combo Box Activates translation of  combo boxes. A drop-down 
 option list, similar to a drop-down menu. Only the 

relevant option is visible when it is not activated. 
 
List Box Activates translation of list boxes (a list where 

multiple options are visible). 
 
 
Tree View Activates translation of Tree View (compare with the 

right-hand pane in Windows Explorer). 
 
Tabs Activates translation of Tabs.  
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Lexicon Editor 

 
Button Function 
 
Target Prefix Automatically adds a prefix before the imported string. 
 For example, the phrase “Vi&ew” can be imported as “Vi&ew” in the source 

language column and as “xxVi&ew” in the target language column.  
 
>>  Add a phrase by double-clicking on the relevant line in the “Captured UI” 

column. The phrase is then removed from the “Captured UI” column and 
finally added to the source language and target language columns. Add 
more phrases by selecting additional phrases, then click the >> button. 
Select a number of phrases by dragging over a frame using the mouse, or by 
holding down the Shift or Ctrl key and then selecting in the same way as in 
Windows Explorer, for example. 

 
Show/Hide Capture Displays phrases captured from the program’s user interface. This 
 function is activated when the “Capture UI” is activated.  
 See the section “Adding phrases from a program’s user interface”. 

 
Find Launches the search function. 
 
Apply Saves changes without closing Lexicon Editor. 
 
New Phrase Adds a new phrase. 
 
Delete Deletes the selected phrases. 
 
Properties Opens the “Phrase Properties” dialog 
 
OK Closes Lexicon Editor and saves changes. 
 
Cancel Closes Lexicon Editor without saving changes 
 
 
Keyboard function in Lexicon Editor 
 
Enter Source/Target: Confirms your edit of the phrase and exits edit mode. 
 Captured UI: Imports selected phrases. 
 
Esc Cancels editing of a phrase. 
 
Ctrl+A Selects all phrases in Source/Target or Captured UI. 
 
Delete Deletes selected phrases. 
 
Tab Confirms your edit of phrase and opens the next phrase for editing. 
 
Shift+Tab Confirms your edit of phrase and opens the previous phrase for editing. 
 
Ctrl+Tab Switches between the Source, Target and Properties columns in edit mode. 
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Search function in Lexicon Editor 
 

 
 
  
 
 
 
 
 
 
 
 
 
 
 

 
Function 
Captured UI Search in “Captured UI” column. 
Source Language Search in “Source Language” column. 
Target Language Search in “Target Language” column. 
Matcha case 
Matcha whole word 
Beginning of phrase 
Get Phrase Use the “Get Phrase” buttons to retrieve phrases from the various 

columns to use as search words. 
 
 
 
Options 
 
Settings:  
Software Translator translates itself.  
All available languages are listed in the 
“Select Language for Software 
Translator" list. Software Translator must 
be re-launched in order for the change to 
apply. 
Remember to close using the icon in the 
taskbar tray to completely close the 
program.  
 
”Show Dictionary in Application list” 
is a function for looking up words and 
phrases from the system dictionary. 
 
”Show Lexicon Information Dialog” 
Before a program starts to be translated, 
a dialog box showing information about 
the dictionary pops up. 
 
 
Updates: 
Eurocity Software publishes updates on its website www.eurocitysoftware.com. Click “Check for 
Update” and Software Translator will check for any available updates. If updates are available, the 
“Get Update” will become active. 
 
System lexicon: 
This is the pointer to the Software Translator system dictionary. This dictionary forms the basis of all 
dictionaries created for each program. If a number of users are to share an adapted system dictionary, 
reset this pointer. 



  20 

Phrase properties in Lexicon Editor 
 
 
Source Phrase 
Original source text to be translated 
 
Target Phrase 
The translated text.  
 
Properties 
Special properties of a phrase. The text in this field 
is formatted automatically in accordance with 
settings for position and size. 
 
Position 
Moves the text in question. The values are relative 
to the original position. Enter negative values to 
move left and up. In the example on the right, the 
text has been moved 4 points upwards (-4). 
 
Size 
Changes the size of, for example, buttons associated with translated text. The values are relative to 
the original size. Specify negative values to reduce the size.  In the example on the right, the height of 
the button has been increased by 14 points. 
 
Control Properties 
Buttons, check boxes, radio buttons and even static texts are called “Controls”. Use the information 
“Title” and “Parent title” to verify that the correct text has been found when the “Get Phrase From 
Screen” function is used. Controls and dialog boxes are often arranged in a parent-child relationship.  
The search dialog in Notepad is the “child” to Notepad’s main window. The search dialog (“Suchen”) 
is the “parent” of the “Sök nästa” button, and so on. 
 
Get Phrase From Screen 
Click and hold the left mouse button. The cursor now changes to a crosshair. Drag the cursor to the 
translated program and position over the text to be changed. Check that the correct text is shown next 
to “Title” in “Control properties”. Once the mouse button is released, the equivalent phrase will be 
looked up in the dictionary and the phrases will be displayed in the Source Phrase and Target Phrase 
fields. If the phrase is not in the dictionary, it will be added. Where this is the case, the source phrase 
will be copied to the Target Phrase field. Then simply change this text to the translated version. 
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Appendix 
 
 
 
TXE file 
 
Txe header information 
 
%99 Source language and Target language 
%101 Registration key. Example: 

HKEY\LOCAL\MACHINE\MyCompany\SOFTWARE\MyProg 
%102 Name of registration data, Example: "Location" 
%103 Free text before registration information 
%104 Free text after registration information 
 

%101-104 together form the search path to the translated program. If, as in the 
example above, the "Location" key points to a folder and not to an .exe file, use lines 
%101-104 as follows: 

 %101 HKEY\LOCAL\MACHINE\SOFTWARE\MyCompany\MyProg 
 %102 Location 
 %104 MyProg.exe 

If the name of the .exe is in the search path in “Location”, line %104 is not required. 
  

If there is no registration key with information about the search path to the program to 
be translated, the entire search path must be entered manually after %104. In such 
circumstances, lines %101-103 are not required. 

 
%110 Translation option in accordance with the settings in the “Application Properties” dialog 
box. 
 Parameters are entered with /+ or /- prefixes, depending on whether they are on or off. 
 
 Default settings: 

/-LOG Log function closed 
/+ICPT Extended (low level) is activated. 
/-ID Deep extended (advanced low level) closed. 
/-SPY Take captured UI closed. 
/-XSPY Advanced take captured UI closed. 
/+MI Translation of menus activated. 
/+TT Translation of tooltips activated. 
/+HD Translation of xxxr activated. 
/+LV Translation of list view activated. 
/+CB Translation of comboboxes activated. 
/+LB Translation of list boxes activated. 
/+TV Translation of tree view activated. 
/+TC Translation of tabs activated. 
/-DUM Test mode closed. 
/+BC Class blocking activated. This function blocks all translation in input 

fields. Any class name can be blocked using the convention 
/BC:ClassName.  

 
Advanced settings: 
/LC:Locale Country code for the character set. 
/CS:CharSet Character set 
/EP:ExePath Search path to the translated program. If the search path in %101-104 

points to a shell program, which in turn launches the program to be 
translated, enter the search path to the program as the parameter /EP. 

 
%111 General options not used by Software Translator. %111 used only by the runtime 

module when Software Translator is run as a hidden translation. 
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Categories and Classes 
 
Categories 
01 Text entered in a control when created 
02 Text in a menu line. 
03 Text in a menu that is displayed when a menu line is activated 
04 Sub-menu 
05 Right-click menu 
06 Text entered in a control when the program is run 
07 Text in a tool tip 
08 Text in a combo box 
09 Text in a list view 
10 Text in a tree view 
11 Column heading in a list view 
12 Tabs 
13 Text in a pop-up menu 
14 Short menu when no document is open in programs that may have multiple documents open 
simultaneously 
 
Low level categories 
 
Categories from no. 15 upwards are known as ‘low level categories’. They can be turned off by using 
the “Extended” and “Deep Extended” options in the “Application Properties” dialog box. The low level 
functions capture text not output by normal Windows text output functions. This can include external 
functions 
such as ActiveX controls. In some cases, no controls are used – all interfaces are drawn “by hand". 
This makes it impossible for Software Translator to guide the text into any of the above categories. 
 
15 Unknown text output 
16 Text output ASCII 
17 Text output Wide Char (Unicode) 
18 Text output ASCII 
19 Text output Wide Char (Unicode) 
20 Text output ASCII 
21 Text output Wide Char (Unicode) 
22 Text output ASCII 
23 Text output Wide Char (Unicode) 
 
32 Text output ASCII 
33 Text output ASCII 
34 String conversion 
35 Size calculation ASCII 
36 Size calculation Wide Char (Unicode) 
37 Size calculation ASCII 
38 Size calculation Wide Char (Unicode) 
 
Example: 
 
The categories are entered in the dictionary before source language entry. Here is an example of an 
English-French phrase: 
“Keys” is translated as “Clés” 
 
If the translation of "Keys" has to be given special treatment in a combobox, category 08, you must 
first make a copy of the phrase. Add the category number at the start of the source phrase. Enter a # 
as the separation symbol between the category number and the source phrase. 
Keys Clés 
08#Keys Keys 
 
In this instance, “Keys” will be translated as “Clés” everywhere in the program except in combo 
boxes, where “keys” will remain not translated.  
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Classes 
 
Below is an example of an option for translation in a .txe file. (see section TXE file). 
%110 /-LOG/+ICPT/-ID/-SPY/-XSPY/+MI/+TT/+HD/+LV/+CB/+LB/+TV/+TC/-DUM/+BC 
 
This is the same option offered in the "Application Properties" dialog box in Software Translator.  
However, some options can only be edited manually direct in the .txe file. 
/BC (Block Class) is one of them. 
 
/+BC is a general block of all classes with names beginning with "Edit" and "RichEdit".  
The idea of this is to prevent translation of input fields. Class blocking can also 
be used to block any class, for example: /+BC:SysTreeView32/+BC:SysListView32 
Objects in Tree Views and List Views will now not be translated. 
 
 
Character sets 
 
Normally, character sets are handled automatically using “National Settings” in the Control Panel. 
Where character sets are specified in a program that is to be translated to a language that uses a 
different character set, Software Translator may need to change character set in conjunction with the 
translation. 
To achieve this, Software Translator has two settings; LC (Locale, or country code) and CS (Character 
Set). 
 
The following is a table showing the various country codes and their character sets. 
 
Language Country code Character set 
Japanese /LC:jpn /CS:128 
Korean /LC:kor /CS:129 
Simplified Chinese /LC:chs /CS:134 
Traditional Chinese /LC:cht /CS:136 
Greek /LC:ell /CS:161 
Turkish /LC:trk /CS:162 
Russian /LC:rus /CS:204 
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Encryption 
 
To prevent improper distribution or use of a dictionary, the .txe file can be encrypted.  
For more information, contact Eurocity Software. 
info@eurocitysoftware.com 
 
 
Special characters 
 
General matching 
 
When Software Translator translates an unknown program, i.e. a program that is translated using the 
system dictionary and not a customized dictionary, the phrases are filtered in order to translate as 
much of the text as possible without precise knowledge of the exact content of the phrases. 
A menu may contain "New" or "&New" or "New..." or "&New..." and so on. 
The & symbol is the special character "Ampersand", which is used by Windows to, for example, link a 
shortcut key to a command in a menu. 
General matching filters out the & symbol and concluding ellipsis, etc. from the phrases as captured 
on the screen. A check is then done to determine whether the phrase is in the dictionary. In this way, 
only one line is needed in the dictionary for all variations of the phrase “New”. 
In a customized dictionary, it is usually better to input all phrase variations. The advantage of this is 
that it affords you better control over the translation. ”New” in an menu can be translated to “Ny”, at the 
same time as “New…” on a button can be translated as “Nytt…”. 
 
 
Wildcards 
 
In order to simplify the management of texts such as: "Status: 25 av 50 filer är kopierade", you can use 
a wildcard, “%s”. In this instance, %s is entered instead of the numbers:  
 
"Status: %s av %s filer är kopierade” is translated as “Status: %s of %s files are copied” 
 
NB: 
1. %s must be entered in both the source phrase and the target phrase. 
2. There must be the same number of %s in the source phrase as in the target phrase. 
3. All %s must fall in the same order 
4. %s must be entered in lower case, %S will NOT work. 
 
 
Line breaks 
 
The .TXE file (dictionary) can only handle one phrase (source and target phrase) per line. 
Line breaks are entered as "\r" for a new paragraph (Carriage return, ASCII 13 x0D). 
Or as "\n" for a new line (Line Feed ASCII 10 x0A). 
 
NB: 
1. You cannot change the position of \r and \n in the source phrase. 
2. \r and \n can be positioned anywhere in the target phrase. 
3. \r and \n must be entered in lower case, \R or \N will NOT work. 
--------------------------------------------------------------------------- 
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Sharing dictionaries over a network 
 
It is very simple to enable multiple users to share a dictionary over a network. 
 
1. Copy the dictionary (.TXE file) to a shared drive on the network. 
2. Right-click the program icon in Software Translator and select “Application Properties” from the 
menu. 
3. Click the “Browse” button and browse to the dictionary. 
 
Sharing a dictionary over a network with hidden translation 
 
The file “XLStart.exe” is responsible for initiating hidden translations. When launched, it starts looking 
for .TXE files in its own folder, then in the folder specified in the “Start in” field in the shortcut. 
 
To share a dictionary with hidden translation, do the following: 
1. Copy the dictionary (.TXE file) to a shared drive on the network. 
2. Right-click the shortcut for XLStart.exe on the desktop or in Windows Explorer. 
3. Specify the search path to the dictionary in the “Start in” field. The search path can either be UNC 
(//servername) or a mapped drive (G:\ServerPath). 
 
 
 
Creating a hidden translation 
 
Software Translator is launched by a file called XLStart.exe. This file has two principal functions, 
to handle authorization and to initiate hidden translations (including translation of Software Translator).  
 
Hidden translation is a way of translating programs without them having to be launched from the 
Software Translator application window. The translation process is initiated automatically when 
XLStart.exe is launched. The actual translation begins automatically when the translated program is 
launched. Therefore, it makes no difference how the program is launched. You could, for example, 
double-click on a document in Windows Explorer. 
 
To initiate the translation automatically when the user boots up the computer, put a shortcut to 
XLStart.exe in the “Autostart” folder. 
 
Txe files that are automatically generated from Software Translator go into a sub-folder in the folder in 
which Software Translator is installed. The folder has the same name as the translated .txe file. 
Move the .txe file up a level to the folder containing XLStart.exe. 
 
Open the .txe file in a text editor such as Notepad. Chang line %111 so that the parameter /+ICON 
becomes /-ICON. This ensures that the translation does not appear as a new icon in Software 
Translator and that the translation will be initiated automatically when XLStart.exe is launched. 
 
The installation files supplied with a hidden translation (Setup.exe), do not normally include Software 
Translator.exe. This means that the user does not have access to the flag interface. 
If the user is to have access to the Software Translator interface, the interface will open automatically 
when XLStart.exe is launched. To prevent this, a parameter can be sent to XLStart.exe which 
determines whether or not Software Translator is to launch automatically. 
 
"XLStart.exe /+UI" Launches Software Translator 
"XLStart.exe /-UI" Prevents Software Translator from launching 
 
If the interface to Software Translator is included in the installation, Software Translator may be 
launched afterwards using the icon in the taskbar tray. Double-click or right-click and select “Visa” from 
the menu. 
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Hints & tips 
 
 
Changing the default value for auto correct in MS Office. 
 
There is a default value for auto correct in MS Office that replaces “...” (three dots in a row) with a 
special symbol that looks like three dots. This feature doesn’t work quite so well when a dictionary 
from Software Translator is imported into MS Office. 
Go to the “Tools” menu and select "Autocorrection...".  Remove “...” from the list. 
 
 
Deactivating “Capture UI”. 
 
Once a program has been run through Software Translator with the “Capture UI” function activated, all 
texts are written down to a .TXI file, for later import to the dictionary. Remember to deactivate “Capture 
UI” once the run is complete. Otherwise, the .TXI file will be overwritten if the program is re-launched 
before the phrases are imported.  
 
 
 
 
Installation options 
 
 
Standard installation 
 
Software Translator is installed using a normal installation wizard. Follow the instructions on screen. 
--------------------------------------------------------------------------- 
 
Installation of hidden translation 
--------------------------------------------------------------------------- 
Installs one or more dedicated translations. Software Translator is run in the background without a 
user interface. The only way the user can see that the translation is active is by the icon in the taskbar 
tray. 
A dictionary for the target program is integrated in the installation (Setup.exe). If required, the 
translation may be started automatically once installation is complete. It is also possible to have a 
shortcut pasted into the Autostart folder so that translation starts automatically when the computer is 
booted up. 
 
 
Custom installation 
 
In this instance, the installation program is supplied without an integrated dictionary. The installation 
copies an external dictionary file. The file must be called “ST.TXE” and be located beside Setup.exe 
on the installation diskette or CD. 
 


